
Building a Poster
using PowerPoint

A guide for using PowerPoint
to present your information

in a large-format poster.

1: Know your story.
What is the main information you want your audience to receive? In the
short time someone will stand in front of your poster, what do you want
them to learn? Be sure the title reflects the story being told and include
only what supports that story. If you’re unsure of your story, the audience
will be too.
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2: Know your audience.
Knowing your audience helps you choose the best way to reach them, and
the best language to use. Are they from your own field or the general public?
Do acronyms need to be defined? If many languages are spoken, consider
less text and more pictures to communicate your story. Remember, some
images or words may be offensive to some audiences.

3: Think about how you are going to use the poster.
You are making a visual tool to convey information to an audience.
Before you begin to design the poster, consider its use.

Where will it be used? How close will the reader be to it?

How much space is allowed to display it?

Will it stand alone or will you be there to add to its content?

Does it need contact information? Website? Phone number?

Will you use it in more than one situation? If so, consider changes to
the content or size to accommodate more than one use.

Did someone give you assistance with, or funding for, your research?
You may want to include an acknowledgment.
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Before opening PowerPoint, assemble everything you want to include on
the poster. This is the time to edit! Ask yourself: ”Is it necessary? Does it
help tell my story?” If the answer is “Not really”, don’t use it.

Make a rough sketch and refer to it as you bring text and images onto the
poster. THIS IS NOT A DESIGN, but a listing of what goes with what, the
general order the poster is to be read, and other requirements, like size.

Arrange all the text and images into main categories; this organizes the
information for the reader and helps them navigate through the poster
without hunting for related parts.

List everything within each category. Keep all graphs and images near
related text. For example, if the text refers to Figure 1, place the figure
nearby and give it a title (you may not have to call it “Figure I”). If a table is
used, place it where the reader will find it useful and give it a title; this can
often eliminate both the need to call it Table 1 and the extra words used to
describe where it is. Don’t expect the reader to hunt for anything; chances
are, they won’t.

Note: In this sample, there are 4 categories of equal importance- Intro,
M&M, Results, and Conclusions; these should have the same body text
size & font, and their subheadings should be the same style. Refs, contact
info, & acknowledgments are less important, smaller text size can be used.

XX” x XX” (max poster size allowed by conference)

3 authors & 2 affiliations

Contact info (write, email, phone) + website

Title

Materials & Methods
• 3 areas, each =

1 sentence and 1 photo
• 2 tables

Results
• 3 graphs (corresponding to 3 areas of M&M)
• 2 paragraphs
• photo of mountain after
• bulleted list of what we accomplished

Conclusions
• 3 bulleted sentences
• 1 photo

Acknowledgments
2 sentences, grant #.

Refs: numbered list of 8

Introduction
• 2 paragraphs
• map of NH, with site marked
• New England map (if room)
• 1 table
• photo of mountain before

NH



6: Begin.
Open PowerPoint (PPT); >File; >New; >Blank Presentation; >Slide layout,
choose the empty box (Blank). Under File, >Page Setup, select Custom
(the default is “On-screen Show”). PPT allows a maximum of 56” in both
dimensions; but since our printers are 44” wide, the largest a PowerPoint
poster can be is 44 x 56 (either vertical or horizontal format).**

** Note: If you participating in the PowerPoint Poster Training and Printing
Service for the URC 2005 from UNH Photographic Services, your poster
MUST BE 36” x 36”, no variation.
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The goal of the poster design is to make the information easy for the
reader to grasp. Anything that does not aid that process is distracting.
Unnecessary words are like boulder fields to climb through. Make the path
easy and the readers will read; your information will reach someone.

Avoid a poster that is all text; remember, you are making a visual tool!
Photos communicate immediately; a strong image can bring people to
your poster. Too much text can be overwhelming; the audience may walk
away. The audience for your poster is standing (unlike sitting to read a
journal article); they may stand for a minute or two - make it easy!

Print out a sample of text at 30pt to get an idea of the space it will occupy
on the poster. Edit!

7: Enter text.

Enter all the main text (paragraphs, not titles) at the final point size (~ 30pt
to be read from 5ft). This will give you an idea of the space remaining for
graphics or images. Captions, references, acknowledgments, and contact
information can be a smaller point size (~18, 24, depending on style).

Choose the text tool; click and drag to make a text box; begin typing;
it will expand as you add text. The text box can be resized to fit any
column width by pulling on the horizontal  handles. Select text and
change font style, size, or color.

Directly in PPT

From Word
With both Word and PPT open: Select the text in Word, Copy, return
to PPT. Create a text box, then Paste.

The text can now be edited; size, font, and color changed. Creating a
text box first is important, because once filled with text, it can be
resized easily and the text will wrap to fit.
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AVOID THIS: “Gray Mass”

Pare down. If the reader spends only 1 minute in front of your poster, don’t make
them work hard, make the information easy to get. Avoid “gray mass”- a large
block of text with no breaks. Create subheadings, pull out key words, pull out a
bulleted list if items are listed, rather than have an important list lost inside the gray
mass. Fonts- 2 or 3, keep it simple. Your poster should put forth your message, not
be an ad for fonts and colors. Generally, a different font or color is used to visually
bind like ideas or attract attention- example- title of poster, subheadings, author,
graph titles. The “body text” -paragraphs of text in each section-  should be easy to
read, generally dark on a light background is easier to read, if there is a large
amount of text. It is usually about 30pt on a poster about 6ft long. Print out a small
section at 30pt and try reading it from 5ft. You may want to change the line spacing
if bottoms of “y’s”, and  tops of  “f’s” are too close. PowerPoint often leaves too
much space between lines (>Format, > line spacing, change to 0 .9 or 0.8).

DO THIS: The “Gray Mass” has been organized for the reader.

Pare down.

Avoid “gray mass”– a large block of text with no breaks.

Create subheadings, pull out key words; if items are listed, use bullets
rather than have an important list get lost inside a “gray mass.”

Don’t make the audience work hard. They may spend only one minute
in front of your poster; make the information easy to get.

Choose a font and color.
Keep it simple; use only 2 or 3. The poster should put forth your
message, not be an ad for fonts and colors. Use the same font or
color to visually bind like ideas and a different font or color to attract
attention.

Choose colors that complement the poster content: a background
color that enhances the images used and a text color that contrasts
enough with the background to be read easily. Generally, dark text on
a light background is easier on the eyes. Lots of white text on a dark
background can start to vibrate!

POWERPOINT POSTER TITLE        (tight)

POWERPOINT   POSTER   TITLE    (with spaces)

Avoid all caps unless more space is added between words.

(The text has been divided into categories and useful headings added.)
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You can type directly in PPT or copy text from Word. With both Word and
PPT open: 1) Select the text in Word (a phrase, paragraph, or entire
section) and copy it.  2) Return to PPT, create a text box, and paste.

The text can now be edited and the size, font, and color of the text box
changed. Creating a text box first is important, because once filled with
text, it can be resized easily and the text will wrap to fit.

Consider the references: Long references within a paragraph can
interrupt a train of thought and take valuable space. You can number
the references and place only the number within the text like this (5).
Be sure the numbers are correct!

Check font size: A good starting point for body text is 30pt on a poster
~6’ long. Print out a small section at 30pt and try reading it from a
distance of 5’. This will give you an idea of how much room it takes.
Remember, changing font styles may change the size; 20pt Arial is
larger than 20pt Palatino.

Adjust line spacing: If the bottom of a y and the top of an f are too
close, enlarge the spacing between lines. If the space is too large,
reduce it from the default 1 to 0.9 or 0.8. The distance between
paragraphs can also be changed; if the space seems too large, try 0.5
(>Format; >Line Spacing). Remember, be consistent.

Use one space between sentences: A space is automatically placed
after an ending punctuation, so one hit on the space bar is enough.

Avoid equal justification: Unless the spacing is quite even to start with,
once justified,

there  are      often   large   gaps.   On   a  large-format    poster,
it   can    look awkward   and        be     hard to    read.

The lines above are equal justified. Some fonts are interpreted by the
printer as shapes and not letters; spaces occur inside a word,
making the sentence difficult, and sometimes humorous to read.
Your information is lost in the shuffle. “Comic sans” is a troublesome
font and does not equal justify well:

hum   orous             diffi      cu lt         insidi        e a wo  rd

Keep text blocks “tidy”: Delete empty spaces. Make sure text blocks
are no larger than the text they contain. If left too large, they may be
“clicked on” by mistake; or, when included in a group, the group may
be overly large. Take this suggestion seriously, it will save you grief.
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Create a simple graph from the beginning, avoiding 3-D elements,
and background grids. Eliminate the legend if elements can be
labeled directly. Often sections of a pie chart can be labeled within
the pie, where the reader can see it quickly.

If you are using an existing graph, simplify it. Select the graph;
>Draw; >Ungroup. Delete everything that is not necessary.
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10: Simplify graphs.

Whenever possible, combine graphs to share axis titles, labels, or
legends. Don’t ask the reader to read anything twice.

Keep it simple. A filled shape doesn’t always need a line around it.

Avoid “Chart Junk,” anything that does not help tell your story: 3-D
graphs, lots of grid lines, shadows, or labels on every tick mark (use
fewer labels and make the remaining ones larger).

9: Import photos.
Insert >Picture >From File, and select the file from wherever it is
stored (folder, desktop, CD…). Images should be at least 100dpi, the
same size they will be on the poster. Unsure of their size in the final
design? Use a rectangle as a place holder and scan it later. Save the
image as a “JPG”;  it is easier to insert into PPT.

Cropping a photo in PPT: Select the image, choose the crop tool from
the Picture palette and crop from any side. The remaining image can
now be resized.  (If the picture tools aren’t in sight, open them under
View; >Toolbars; >Picture.) Experiment with these tools for enhancing
images. Know that you can reverse this crop and get your image back.

“Framing” photos: Select the image, view at 100%, >Format, >Colors
and Lines, leave the fill “none.” Select a line color and width to add a
border around the photo. The default width is quite thin; try 1.0 or 1.5.



10: Simplify graphs. (cont.)

Quarter
1st 2nd 3rd 4th

0

40

80

East
West
North

0

40

80

N
um

be
r 

of
 S

tu
de

nt
s

1977

1978

Further cleaning:

The bars were grouped and stretched to the right to accommodate
larger, lower axis labels (this did not change the accuracy).
Tick marks between bar groups were deleted.
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Increase the point size of lines and remaining text, staying
consistent with all graphs. You may want to extend the length of
some or all tick marks.

Change colors to complement the entire poster; make sure the
colors you choose for symbols are different enough from each
other and contrast with the background.

Create and “clean” graph in a separate PPT file;  it will save
zooming in and out. Copy and paste it into the poster; group all of
parts and resize (hold Shift to keep proportions and lettering from
being distorted). If some of the text-wraps have changed during the
resizing, ungroup the graph and, one by one, pull out each text
block so words aren’t broken. You may want to change the font
sizes, styles, or colors.

If 2 or more graphs are grouped together and have the same axis
numbers and/or titles, let them share. The remaining titles or labels
(or dates, as in the example) should clearly identify the difference
between them. The graphs can share a larger title.
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Extra guides, where to get them: Select a guide (if no guides, >View;
>Guides), hold Ctrl [PC] or  Alt [MAC] as you drag another guide from
it. Click on the guide at the edge of the poster or away from anything
that you don’t want selected and moved by mistake. The number of
guides is finite! Be sure not to move the guides into the gray area
outside the poster, they can’t be retrieved.

Use guides to set margins and columns. What seems “close enough”
on your 17” screen might not be so nice when seen 5 feet wide.
Uneven edges detract from the readers concentration!

Use guides to help align* shapes: select one shape at a time and
bring it to a guide. Select all of them (holding Shift as you add more to
your collection), Group them, and move them as a group to their new
location.

 * or use the Align tool: >Draw, >Align, > Align left (or right, top...)

Duplicating anything: Select a text block, image, shape, or group of
things, then hit Ctrl+D [PC] or Apple +D [MAC] for Duplicate. If it is
text, you simply need to edit, the formatting is done! Subtitle styles
such as “Conclusions”, with a band of color behind the text, can be
made by building a template and duplicating it; keeping the style
consistent.

ß Create a text box with the longest title and the one with tall 
letters like “k” or “g”; this ensures that all text will fit the 
template you are building.

ß Create a rectangle (or any shape); give it a color and/or line;
send it behind the text box (>Draw; >Order; Send to Back).

ß Group the text box and colored shape, duplicating the group,
then edit the text (i.e. change “Conclusions” to “Results”).

The wee nudge: Things attach themselves to an invisible grid, and
sometimes this is not where you want them. To get just a wee nudge,
hold Alt [PC] or Apple [MAC] as you click and drag the guide, object,
text box, or group.  Place it exactly where you want!

Future Happenings

Future Happenings

Past Events Future Happenings

Shape sent behind text box.

Shape and text box grouped.

Fill options endless:Text edited, group stays intact:
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Margins:
Whatever size margin you choose, be sure left and right are the same; for a
36”- or 44”-wide poster, 1 1/2” to 2” is good for side margins. A general
guideline: top and side margins are the same and the bottom margin is
slightly larger than the top. This provides a good” visual base” for the poster
to rest on. Good side margins help “frame” the poster, separating it from the
others placed nearby. Use the guides to set margins. No guides?

View >Guides, and make sure “Guides” is checked.

Some extras...

Bullets: Let them do their job.

ß Put a space after the bullet and tab the text over, so the bullets 
are in a column by themselves to highlight the lines.

ß Be aware of what you are listing. Use a different size or color 
bullet for each level of information.

ß Don’t use a bullet if there is only one item (no list).

About Bullets

Create a shape with the box or circle tool (hold Shift if you want an
exact square or circle); >Format; >Colors and Lines, choose a fill,
no line (or just a line, no fill…). With the shape selected, duplicate it
with keys Ctrl+D [PC] or Apple+D [Mac]. Vertically line up boxes
along a guide (or use the align tool*) and move them as a group.
Select one at a time and move it into place with the arrow keys.

* >Draw, >Align, > Align left (or right, top...)

Down side: Takes a bit of time.
Plus side: Your bullets are unique, custom made for your needs.
Because the text box is on its own, problems with tabs and indents
are avoided. You don’t have to play the Tab Game!
Caution: Group the bullet shapes with the text box.

Hand Made

Standard Made
These are made within the text box: Select the line or lines of text;
>Format; >Bullet, choose a style and a percentage of the font size.
Experiment with different percentages; the default size often looks
more like a period than a bullet. For simple lists with no text wraps,
(each item being only one line) this way of making bullets is fine.

To delete a bullet, select the line; >Format; >Bullet; choose “none”.

Making Bullets: 2 Methods
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have patience • keep it simple • save often

Remember:
If it doesn’t help tell your story, don’t use it.

(updated January 2005, call us to receive the latest version)
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Format >Slide Background, >Background Fill, choose a color from those
listed; choose More Colors; or choose Fill Effects for a gradient.

Trying to decide on a background? Ask yourself, “What helps tell my story?”

Choosing a poster background:

ß A Background Color: It should complement the poster content and 
images. Experiment with different colors; you can change it any time. 
Keep the contrast high between text and background so that it is easy 
to read. Know that every printer will interpret the colors differently; 
check our color charts to see how our printer interprets your choice.

ß A Background Template: Treat it like a recipe, not a prescription; 
ungroup it, delete or alter any part that doesn’t support your story.

ß A Photograph: It can be great background but the text over it must be 
easy to read. If light text is over a light area in the photo, you may want
to put a rectangle of a darker color behind the text (or a rectangle of 
light color behind dark text on a dark photo).

Experiment with transparent color under the text so the photo will still 
be visible. Place the photo on the slide master to avoid unintentionally 
selecting it.

Referring to your sketch (step 4 above), place everything for each category
together (text, images, graphs..); this will help to determine column widths.
The columns don’t have to be the same size; however, the space between
should be the same. The width of a column is determined by the content it
needs to hold.

The reader should not have to hunt for anything. Avoid, for example, having
only 3 of 4 items in one column and the 4th somewhere else; they may read
only three and miss the 4th.

Deciding on a column width:


